
Задание 1. Имитационное моделирование лентопродящей системы рулонной 

печатной машины в среде MatLab 1.  

Цель работы: 

Изучение программы имитационного моделирования Mathlab & Simulink. Получение 

общих сведений о работе в программе Mathlab и об основных элементах библиотеки Simulink. 

Освоение метода построения имитационных моделей, используя стандартные блоки 

библиотеки Simulink. Математический анализ участка бумажной ленты, как элемента 

лентопроводящей системы рулонной печатной машины. Применение программы Mathlab & 

Simulink для моделирования участка бумажной ленты. Получение основных переходных 

характеристик. 

2. Теоретическое обоснование  

На рис.1 показана схема i-ого участка бумажной ленты, расположенного между двумя 

соседними бумаговедущими парами (БВПi и БВПi+1). Длина пути бумажной ленты может 

меняться за счет перемещения регистрового валика (РВ). 

На данном рисунке использованы следующие обозначения:  

ω, рад/с — угловая скорость вращения i-той бумаговедущей пары (БВП);  

D, м — диаметр цилиндров БВП (принимаем, что диаметры всех цилиндров одинаковы);  

Vi, м/с — линейная скорость подачи бумажной ленты через i-ю бумаговедущую пару;  

Li, м — длина пути бумажной ленты между точками А и В;  

Lном, м — номинальная длина участка бумажной ленты между точками А и В; 

ΔLi, м – приращение пути бумажной ленты, обусловленное перемещением регистрового 

валика. 
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Рис.1. Схема участка бумажной ленты 

Тогда полная длина пути ленты определится как сумма длин 

i
ном
ii LLL Δ+=  
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Предполагается, что лента движется через бумаговедущие пары без скольжения, т.е. 

линейные скорости элементов ленты в точках касания А и В равны линейным скоростям 

ведущих цилиндров. 

Запишем формулу для относительного удлинения ленты:  

( )      i LLL oioii /−=ε                                                                (1.1) 

где L0i, м – длина участка бумажной ленты в нерастянутом состоянии (при отсутствии 

продольной деформации). 

На рис. 2 показана диаграмма растяжения бумажной ленты под действием механического 

напряжения σ. На ней можно выделить три участка. 
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Рис. 2. Диаграмма растяжения бумажной ленты 

Участок 1, характеризуется действием упругой линейной деформации, когда 

относительное удлинение ε пропорционально механическому напряжению σ. При этом 

внутренняя структура бумаги не нарушается. После снятия напряжения восстанавливается 

исходная длина испытуемого образца. На пологом участке 3 под действием механических 

напряжений начинается нарушение межмолекулярных связей. При этом материал «тянется», а 

после снятия напряжения исходная его молекулярная структура полностью не 

восстанавливается. Это участок характеризует действие релаксационных деформаций. На 

участке 3 происходит разрыв межмолекулярных связей с последующим разрушением ленты. 

В дальнейшем, мы будем рассматривать поведение ленты, соответствующее участку 1, 

который характеризует действие упругих деформаций. 

Для типографской бумаги №1, имеющей толщину δ = 0,078 мм, удельное разрывное 

усилие составляет величину Fудразр = (140 – 160) кГс/м. При ширине бумажного полотна b = 0,84 

м механическое разрушение наступает при следующем разрывном усилии 

 кГс/м 160) - (140  =разр
уд .

F

На линейном участке относительное удлинение ленты пропорционально напряжению. Эта 

связь описывается формулой 

ε=σ бE                                                   (1.2) 
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где Еб, Н/м2 — модуль упругости бумаги. 

Зная критическое значение усилия разрыва бумаги Fразр, можно определить разрывное 

напряжение (1,79-2,04) кГс/мм2. =δ=σ )/(bFразрразр

В табл.1 приведены данные о значениях удельного разрывного усилия для разных сортов 

бумажной ленты 

Таблица 1.1 

Данные о значениях удельного разрывного усилия для разных сортов бумаги 

Тип бумаги Толщина в мм, δ 
Удельное разрывное 

усилие в кН/м,  

газетно-рулонная 0,088-0,091 1,24-1,55 

типографская 0,077-0,078 1,08-1,40 

офсетная 0,108-0,300 1,40-5,40 

глубокой печати 0,088-0,126 1,23-2,24 

 

Поскольку модуль упругости бумаги Еб =(640 + 660) кГс/мм2, то можно найти 

относительное удлинение бумажной ленты в режиме разрыва  = (0,0027-

0,03). Номинальное значение натяжения ленты принимается примерно 

FH= (0,3 – 0,4)Fразр. 

Отсюда имеем εном=(0,3 – 0,4)εразр и εном≈ 0,001. Из формулы (1.1) следует:  
 LoiLiiLoi −=ε  

или  

( ) 1/ ε+= ioi LiL  
В результате имеем 

0 1
=

+ ε
i

i
i

LL                                                                       (1.3) 

Мы получили, что длина нерастянутой ленты  обратно пропорциональна ее 

относительному удлинению. 

За одну секунду через i-тую бумаговедущую пару подается длина нерастянутой бумажной 

ленты , а выводится за это же время через (i+1)-ую бумаговедущую пару длина — 

. 

( 1/ 1 −+ εi iV

( )+ εi i

)

1 / 1+V

Тогда за бесконечно малое время dt изменение длины нерастянутой ленты на i-том 

участке составит величину 
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dt
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Отсюда можно найти скорость изменения длины нерастянутой ленты, разделив обе части 

формулы полученной формулы на дифференциал времени dt. 

0

11 1
+

−

= − 1

+ ε +
i i i

i i

dL V V
dt ε

                                                                        (1.5) 

Продифференцируем теперь формулу (1.3) по времени. В результате получим выражение: 

( ) dt
dL

dt
Ld

dt
Ld i

i

ii

i

oi ε⋅
ε+

−⋅
ε+

=
11

1
2                                                    (1.6) 

Исключим переменную , приравняв правые части выражений (1.5) и (1.6) dt/dL i0

( ) i

i

i

ii

ii

VV
dt

dLi
dt
Lid

ε+
−

ε+
=

ε
⋅

ε+
−⋅

ε+
+

− 1111
1 1

1
2                                         (1.7) 

Умножим теперь выражение (1.7) на произведение ( ) ( )11 1−+ ε ⋅ + εi i  и получим нелинейное 

дифференциальное уравнение ленты: 

( ) ( ) ( ) 11
1

1 11
1

1
1 +−

−
− ε+−⋅ε+=

ε
ε+

ε+
−⋅ε+ iiii

i

i

i
i VV

dt
d

Lidt
Lid

                           (1.8) 

Данное дифференциальное уравнение относится к числу нелинейных уравнений первого 

порядка. Полученное дифференциальное уравнение (1.8) можно упростить, разделив его обе 

части на величину (  и рассмотрев в качестве исходного уравнение: )1+ εi

( ) ( ) ( ) 111 111 +−− ε+−⋅ε+=
ε

−⋅ε+ iiii
i

i VV
dt

d
Lidt

Lid                                    (1.9) 

Так как относительное удлинение ленты г{ не превышает 0,002 – 0,003, то коэффициент 

при переменной dt/d iε  можно принять приблизительно равным единице, 

т.е. ( )  (11 1 ε+ε+ − ii / ) 1≈

В результате мы получаем дифференциальное уравнение участка бумажной ленты 

( ) ( ) ( ) 111 111 +−− ε+−⋅ε+=
ε

−⋅ε+ iiii
i

i VV
dt

d
Lidt

Lid                                          (1.10) 

Дифференциальное уравнение участка бумажной ленты (1.10) является нелинейным и 

имеет четыре входных переменных Li, εi-1, Vi, Vi-1 и одну выходную переменную εi. На рис. 1.3 

показана структурная схема участка бумажной ленты с четырьмя входными и одной выходной 

переменными 
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Рис.1.3. Структурная схема участка бумажной ленты 

Перенесем в левую часть слагаемые, содержащие выходную переменную. В результате 

получим нелинейное уравнение: 

( )
dt
Ld

VVVVdt
d

L i
iiiiiii

i
i ⋅ε++ε⋅+−=ε⋅+ε⋅ −−++ 1111 1                                         (1.11) 

Произведем линеаризацию уравнения (1.11) в малых отклонениях от установившегося 

режима. 

Воспользуемся структурной схемой (рис. 1.3) и следующими математическими 

соотношениями для создания компьютерной модели: 

1
0 0

10
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+  

0
01

i
i

LL′ =
′+ ε
                                                                                                                              (1.12) 

0
0

b

F
b E

′
′ε =

δ
         

( ) ( )( ) ( )0 01/i i iL t L t L tε = −    

Составим таблицу значений основных параметров, используемых для расчета участка 

бумажной ленты (табл. 1.2). 

Таблица 1.2. 

Исходные значения параметров 

Задание 
номинальных 
значений 

Координаты Отклонения Параметры 

0F , кГс – сила 
натяжения ленты 

0F ′ , кГс – начальное 
натяжение ленты 

, м/с – скорость 
печати 

м - длина пути 
ленты 

0V

0L , 

( ) ( )1 0 1 1i it t− −ε = ε + Δε ⋅  

( ) ( )0 1i iV t V V t= + Δ ⋅  

( ) ( )1 0 1 1i iV t V V t+ += + Δ ⋅  

( ) ( )0i iL t L L t= + Δ  

0 00.2Δε = ⋅ε  

0 00.2iV VΔ = ⋅ ⋅ε  

1 00.2iV V+ 0Δ = ⋅ ⋅ε  

0 00.2iL LΔ = ⋅ ⋅ε  

30.078 10−δ = ⋅ м – 
толщина ленты 

=0.84 м – ширина 
ленты 

= 660 кГс/мм2 – 
модуль упругости 
бумаги 

 - 
номинальное 
относительное 
удлинение ленты 

b

bE

( )0 0 / bF b Eε = δ
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начения: V0 = 6 м/с, F0 = 30 кГс, L0 = 17 м. 

ьютерной модели буде  использовать сам я ы аммирования для 

реше  задач Matlab и пакет асширения Simulink. 

рядок выполнения работы 

мму Matlab, в появившимся командном окне (рис. 1.4) введем оманду 

simulink для запуска пакета графического моделирования Simulink ил чок

 

Номинальные з

Для создания комп м з к прогр

ния технических

3. По

р

Запустим програ  к

и нажмем на зна   

на панели задач основного окна Matlab. 

 
Рис. 1.4. Командное окно программы Matlab 

Откроется библиотека блоков Simulink Library Browser (рис. 1.5). В данной библиотеке 

блоки разделены на различные группы и подгруппы по различным функциям, задачам и 

операциям, которые они выполняют и решают. Нажмем на значок  для создания новой 

Simulink-модели или нажмем комбинацию клавиш Ctrl+N. 



 
Рис. 1.5. Библиотека блоков Simulink 

После открытия новой модели создадим компьютерную модель участка бумажной ленты. 

Все отношения входных и выходных переменных, значения этих переменных и  постоянные 

значения параметров выразим через стандартные блоки библиотеки Simulink. Постоянные 

значения типа толщина ленты δ, ширина ленты b, модуль упругости бумаги Еb, номинальное 

относительное удлинение ленты можно выразить через блок Constant, расположенный в 

Simulink/Sources (рис. 1.6). Параметры этого блока можно ввести через командное окно (рис. 

1.7). 

 
Рис. 1.6. Окно блока Constant 
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Рис. 1.7. Ввод значение параметра Constant через командное окно 

Математические отношения различных переменных выражаются через блоки 

математических операций: деление – через блок Divide, умножение – через блок Product, 

суммирование и разность – через блок Sum (Simulink/Math Operations).  

 
Рис. 1.8. Блоки математических операций 
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Для сложных математических операций, таких как интегрирование и дифференцирование, 

а также представление дифференциальных уравнений через передаточные функции, 

пространство состояний и др. используются блоки Derivative, Integrator и т.д., которые 

расположены в Simulink / Continuous (рис. 1.9). 

 

 
Рис. 1.9. Блоки сложных математических операций 

Для просмотра результатов моделирования, в виде графиков, переходных характеристик 

или численных значений, а также для записи и сохранения полученных результатов для 

дальнейшего использования имеются блоки, находящиеся в разделе Simulink/Sinks (рис. 1.10). 

 
Рис. 1.10. Блоки для отображения результатов моделирования 

Далее расположим и соединим блоки в Simulink-модели на основании системы уравнений 

(1.12) и табл. 2, используя рассмотренные выше стандартные блоки (рис. 1.11). Нажмем на 

кнопку  на панели команд или выберем пункт меню Simulation>Start в окне модели для 

запуска процесса компьютерного моделирования. По умолчанию локальное время 

моделирования 10 секунд, это время можно изменить с помощью окна на панели команд 

 или через пункт меню Simulation>Configuration Parameters. Чтобы 

остановить процесс моделирования можно нажать на кнопку  или выбрать пункт меню 

Simulation>Stop. 
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Рис. 1.12. Simulink-модель участка бумажной ленты 

 
Рис. 1.13. Окно параметров настройки блока Step 

Для выражения единичного ступенчатого воздействия 1(t) был использован блок Step – 

генератор ступенчатого сигнала (Simulink/Sources) со следующими параметрами (рис.1.13): 

Step time – Время наступления перепада сигнала (секунды): 0; 
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Initial value – Начальное значение сигнала: 0; 

Final value – Конечное значение сигнала: 1. 

Изменение относительного удлинения ленты εi можно наблюдать на осциллографе (Scope) 

подписанного как epsi(t), а изменение силы натяжения Fi – на осциллографе подписанного как 

Fi(t) (рис. 1.14 и рис. 1.15). Время моделирования для данной системы составило 60 секунд. 

  
Рис. 1.14. Изменение относительного 

удлинения 
Рис. 1.15. Изменение силы натяжения 

Для удобства представления и дальнейшего использования компьютерной модели можно 

скомпоновать блоки с помощью создания подсистемы (Subsystem). 

Подсистема (Subsystem) – это фрагмент Simulink-модели, оформленный в виде отдельного 

блока. Использование подсистем при составлении модели имеет следующие положительные 

стороны: 

1. Уменьшает количество одновременно отображаемых блоков на экране, что 

облегчает восприятие модели (в идеале модель полностью должна отображаться на 

экране монитора). 

2. Позволяет создавать и отлаживать фрагменты модели по отдельности, что 

повышает технологичность создания модели. 

3. Позволяет создавать собственные библиотеки. 

4. Дает возможность синхронизации параллельно работающих подсистем. 

5. Позволяет включать в модель собственные справочные средства. 

6. Дает возможность связывать подсистему с каким-либо m-файлом, обеспечивая 

запуск этого файла при открытии подсистемы (нестандартное открытие 

подсистемы). 

Для создания в модели подсистемы можно воспользоваться двумя способами: 

1. Скопировать нужную подсистему из библиотеки Simulink/Ports&Subsystems в 

модель. 

  15



  16

2. Выделить с помощью мыши нужный фрагмент модели и выполнить команду Create 

Subsystem из меню Edit окна модели. Выделенный фрагмент будет помещен в 

подсистему, а входы и выходы подсистемы будут снабжены соответствующими 

портами. Отменить группировку блоков в подсистему можно командой Undo. 

Для данной модели участка бумажной ленты создадим 2 подсистемы: параметры 

(Parametri) и лента (Lenta). Входы (Input) и выходы (Output) для каждой из подсистем подпишем 

для удобства использования. Изображения эти подсистем представлены на следующих 

рисунках (рис. 1.15 и рис. 1.16). 

 



 

 

Рис. 1.15. Блоки, расположенные в подсистеме Parametri Рис. 1.16. Блоки, расположенные в подсистеме Lenta 
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В подсистеме Lenta можно посмотреть результаты моделирования силы натяжения ленты. 

Для этого в подсистему был размещен осциллограф Fi(t). Окно этого осциллографа показан на 

следующем рисунке (рис. 1.17).  

 
Рис. 1.17. Результаты моделирования силы натяжения ленты. 

После того как были собраны подсистемы, можно соединить их для получения 

имитационной модели участка бумажной ленты (рис. 1.18). После запуска моделирования 

можно посмотреть результаты изменения силы натяжения и относительного удлинения ленты 

на осциллографах (рис. 1.19 и рис. 1.20). 



 
Рис. 1.18. Скомпонованная имитационная модель 

  

Рис. 1.19. Изменение силы натяжения Рис. 1.20. Изменение относительного 
удлинения ленты 

Сформулировать выводы по результатам выполнения данной лабораторной работы. 
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Задание 3. Исследование линеаризованной математической модели 

лентопроводящей системы рулонной печатной машины среде MatLab 

1. Цель работы 

Построение линейной модели участка бумажной ленты в пакете расширения Matlab 

Simulink. Исследование реакций модели на различные входные воздействия. Изучение 

построения частотных характеристик в Simulink. Получение логарифмических частотных 

характеристик в Simulink.  

2. Теоретическая часть 

Рассмотрим установившийся режим работы участка бумажной ленты, предположив, что 

 и   0=ε dt/d i 0=dt/d Li . 

Примем, что установившиеся значения входных и выходных переменных описываются 

выражениями: Vi=Vi+1=V*; Li=Li
*; εi-1= εi-1= ε*. 

Найдем уравнение статической характеристики: 

V*ε* = (1+ ε*)·0+ V*– V*+ V*ε*; 

Введем малые приращения входных и выходных координат участка ленты: Δεi = εi – ε*; 

Δεi-1 = εi-1 – ε*; ΔVi = Vi – V*; ΔVi+1 = Vi+1 – V*; ΔLi = Li – Li
*. Тогда, можно произвести замену 

переменных: εi = ε* +Δεi; εi-1 = ε* + Δεi-1; Vi = V* +ΔVi; Vi+1 = V* +ΔVi+1; Li = Li
* + ΔLi. 

Очевидно, что производные от координат равны производным от приращений, т.е. 

dt/ddt/d ii εΔ=ε ,  dt/ddtd LL ii Δ=/   

После замены переменных получаем выражение: 

( ) ( ) ( ) ( ) −Δ++
Δ

⋅Δ++=Δ+⋅Δ++
Δ

Δ+ ∗
−

∗∗∗∗ εεεεε VVLVVLL i
i

iii
i

i dt
d

dt
d

11  

( ) ( )εε −
∗

+
∗∗ Δ+⋅Δ++−Δ− 11 iii VVVV  

Перенесем входные переменные в правую часть 

( ) ( ) ( ) VVVLVL iii
i

i
i

i dt
d

dt
d

Δ+−Δ++Δ+
Δ

⋅+=Δ+
Δ

⋅ εεεεεε ∗
+

∗
−

∗∗∗∗ 111 11             (3.1) 

Разделим обе части уравнения (3.1) на V*. В результате мы получаем линеаризованное 

уравнение участка бумажной ленты: 

iiiV
i

Li
i

i )(k
dt

d
k

dt
d

VVLT εΔ+Δ−Δ+
Δ

=εΔ+
εΔ

+1 ,                                            (3.2) 

где  – постоянная времени (или время заполнения) участка бумажной ленты; V ∗LT /ii
∗=

( ) VVL kk ∗ε+== /1 ∗  – коэффициенты передачи участка бумажной ленты по каналам «Li→εi», «Vi+1 

→ εi» и «Vi → εi». 
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На рис. 3.1 представлена линеаризованная математическая модель участка бумажной 

ленты. Видно, что в динамическом отношении участок бумажной ленты представляет собой 

инерционное звено первого порядка. Это звено имеет постоянную времени Тi. 

ΔLi

Δεi-1

ΔVi 

ΔVi+1
Δεi 

Vk 1
1
+pTi

 

pkL  

 
Рис. 3.1. Линеаризованная математическая модель участка бумажной ленты 

По каналу натяжения «Δεi-1 → Δεi» участок ленты имеет коэффициент передачи равный 

единице. По скорости входной бумаговедущей пары ΔVi участок бумажной ленты имеет 

коэффициент передачи «минус kV», т.е. при увеличении скорости подаваемой бумажной ленты 

установившееся значение натяжения падает. По скорости выводной бумаговедущей пары ΔVi+1 

участок бумажной ленты имеет коэффициент передачи kV, т.е. при увеличении скорости 

выводящей пары установившиеся значение натяжения возрастает. По каналу изменения длины 

бумажной ленты «ΔLi → Δεi» участок ленты имеет дифференцирующие свойства с 

коэффициентом передачи kL. 

Переходные характеристики участка бумажной ленты 

Найдем переходную характеристику участка бумажной ленты по каналу «Δεi-1→Δεi». В 

этом случае его на входе действует ступенчатое возмущение Δεi-1=Δεi-1(t). При этом 

изображение входного сигнала можно найти как его преобразование Лапласа 

[ ] p/)t(L)p( iii 111 1 −−− εΔ=εΔ=εΔ . 

В соответствии с математической моделью участка бумажной ленты изображение 

выходного сигнала будет иметь вид: 

ppT
)p()p(W)p( i

i
ii ii

1
1 1

1
1

−
−εε

εΔ
+

=εΔ=εΔ
−

                                       (3.3) 

Определим обратное преобразование от изображения выходного сигнала 

⎥
⎦

⎤
⎢
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⎡ εΔ
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11
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⎟
⎟

⎠

⎞

⎜
⎜

⎝

⎛
−εΔ

−

−
iT
t

i e11                                      (3.4) 

На рис. 3.2 показана переходная характеристика участка бумажной ленты по каналу «Δεi-

1→Δεi». 
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Рис. 3.2. Переходная характеристика участка бумажной ленты по каналу «Δεi-1→Δεi» 

Данная характеристика показывает, что при ступенчатом изменении входного 

относительного удлинения εi-1, выходной сигнал участка бумажной ленты εi(t) меняется по 

экспоненте. Время установления переходного процесса составляет примерно три постоянных 

времени (tуст≈3Ti), а установившееся значение относительного удлинения ленты на этом участке 

Δεi
уст=Δεi-1. 

Определим переходную характеристику по ступенчатому изменению скорости i-той 

бумаговедущей пары, т.е. по каналу «ΔVi→Δεi». В этом случае преобразование Лапласа от 

выходного сигнала имеет вид: 

( ) ( ) ( )
p
V

pT
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pVpWp i
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V
iVi ii

Δ
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−
=Δ=εΔ ε 1

                                                  (3.5) 

Найдем обратное преобразование Лапласа от изображения (3.5): 

⎥
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где ( )( ) i
**

iV
уст
i VV/Vk Δε+−=Δ−=εΔ 1 . 

На рис. 3.3 представлена переходная характеристика участка бумажной ленты по каналу 

ΔVi→Δεi. Видно, что и в этом случае относительное удлинение ленты уменьшается по 

экспоненциальному закону. Время установления переходных процессов также составляет три 

постоянных времени (tуст≈3Ti), а установившееся значение пропорционально относительному 

изменению скорости i-той бумаговедущей пары. 
 

t

Δεi 

Δεi
уст  

   
t 

ΔVi 

( )1iV tΔ ⋅

 
Рис. 3.3 Переходная характеристика участка бумажной ленты при ступенчатом 

изменении скорости i-той бумаговедущей пары. 

Найдем теперь переходную характеристику участка бумажной ленты по каналу ΔVi+1→Δεi. 

В этом случае преобразование Лапласа от выходного сигнала описывается формулой: 
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  Этому изображению соответствует переходная характеристика: 
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где ( )( ) 11 1 ++ Δε+=Δ=εΔ i
**

iV
уст
i VV/Vk  – установившееся значение выходного сигнала. 

График переходной характеристики участка бумажной ленты по каналу ΔVi+1→Δεi 

показан на рис. 3.4. 
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Рис. 3.4. Переходная характеристика участка бумажной ленты по каналу ΔVi+1→Δεi 

Видно, что эта переходная характеристика аналогична предыдущей характеристике, 

полученной по каналу ΔVi→Δεi. Разница состоит в том, что здесь выходной сигнал не убывает, 

а возрастает. 

Изображение переходной характеристики по каналу ΔLi→Δεi имеет вид: 
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Ему соответствует обратное преобразование Лапласа: 
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где ( ) *
i

*
i

max
i L/L ε+Δ=ε 1  – максимальное значение выходного сигнала. 

График переходной характеристики, описываемой формулой (3.10), показан на рис. 3.5. 
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Рис. 3.5. Переходная характеристика участка бумажной ленты по каналу ΔLi→Δεi 

В этом случае бумажная лента, при ступенчатом увеличении длины ее пути ΔLi, сначала 

натягивается. При этом ее натяжение мгновенно возрастает до максимальной величины Δεi
max. 

Затем натяжение по экспоненте убывает по мере того, как участок заполняется новой 

нерастянутой бумажной лентой. Очевидно, что за счет изменения длины участка нельзя 

управлять натяжением ленты. 
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3. Практическая часть 

Откроем программу Matlab. Запустим графический пакет Simulink и создадим новую 

Simulink-модель. Эта модель будет иметь следующий вид (рис.3.6). В блоке Scope (на данном 

схеме отмечен как Fn) можно установить входы для отображения нескольких графиков 

изменений системы. Для этого нужно сделать двойной щелчок правой кнопкой мышки на 

самом блоке, в открывшемся окне нажать на кнопку Parameters  и в данном случае в поле 

Number of Axes (количество осей) набрать 4 (рис. 3.2). 

 
Рис. 3.6. Simulink-модель участка ленты. 

 
Рис. 3.7. Окно параметров Scope.  

Для исследования реакций системы на различные входные изменения (ΔV1, ΔV2, Δε0 и 

ΔL1) в модель были добавлены блоки Step для создания ступенчатого изменения входных 

параметров (рис. 3.8). Эти элементы переключались вручную с помощью блока Manual Switch 

, расположенного в библиотеки Simulink/Signal Routing.  
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Рис. 3.8. Окно параметров блока Step. 

Далее для исследования изменения силы натяжения и относительного удлинения при 

определенных значениях параметров ΔV1, ΔV2, Δε0 и ΔL1 переключаем блок Manual Switch, 

запускаем процесс моделирования и смотрим результаты в блоках Scope Fn и eps1: 

1. Реакция на ступенчатое изменение ΔV1; 

2. Реакция на ступенчатое изменение ΔV2; 

3. Реакция на ступенчатое изменение Δε0; 

4. Реакция на ступенчатое изменение ΔL1. 

После получения результатов данного моделирования приступим к проведению 

моделирования для получения логарифмических частотных характеристик: логарифмической 

амплитудно-частотной (ЛАЧХ) и логарифмической фазово-частотной характеристики (ЛФЧХ). 

Для этого вначале нужно определить входные и выходные точки для снятия показаний и 

построения частотных характеристик. Для создания входной точки нужно на линии связи 

нажать правую кнопку мыши и появившимся меню выбрать Linearization Points> Input Point 

(рис. 3.9). Над линией связи появиться значок , который показывает местоположение входа. 
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Рис. 3.9. Меню для создания входов и выходов для исследования частотных 

характеристик 
Аналогично создается выходная точка – в меню Linearization Points> Output Point. Над 

линией связи появиться значок , который показывает местоположение выхода. 

После создания входов и выходов в самой Simulink-модели в основном меню выбираем 

Tools>Control Design>Linear Analisys. Откроется окно, в котором появиться входные и 

выходные точки (рис. 3.5). В нижней части окно из открывающегося списка выберем один из 

графиков представления частотной характеристики (рис. 3.10). 

 
Рис. 3.10. Главное окно для настройки 

Выбрав нужную нам частотную характеристику, в данном случае это логарифмическая и 

фазовая частотная характеристики Bode magnitude plot можно начать моделирование, нажав на 

кнопку Linearize Model напротив выбора частотных характеристик. 
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Рис. 3.11. Меню выбора частотных характеристик 

На следующих рисунках показаны примерные логарифмические частотные 

характеристики системы по различным каналам (рис. 3.12 – 3.15). 

  
Рис. 3.12. Логарифмические частотные 
характеристики по каналу «ΔV1→ Δε1» 

Рис. 3.13. Логарифмические частотные 
характеристики по каналу «ΔV2→ Δε1» 
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Рис. 3.14. Логарифмические частотные 
характеристики по каналу «Δε0→ Δε1» 

Рис. 3.15. Логарифмические частотные 
характеристики по каналу «ΔL1→ Δε1» 

После выполнения работы следует проанализировать полученные результаты 

моделирования, сделать выводы о процессе выполнения задания и данных результатах 

моделирования. 
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Задание 6. Имитационное моделирование системы управления натяжением с 

тензодатчиком и пружинно-масляным амортизатором» 

Цель работы 

Создание компьютерной модели системы управления натяжением в пакете расширения 

программы Mathlab Simulink. Исследования замкнутых и разомкнутых систем управления 

натяжением ленты.  Получение графиков изменения натяжения ленты, момента инерции и 

скорости печати. Получение логарифмических и переходных характеристик системы на 

различных этапах работы системы.  

2. Практическая часть 

Откроем программу Matlab. Запустим пакет графического моделирования Simulink. На 

основе математического описания и математической модели (рис. 6.1) системы управления 

натяжением с тензодатчиком и пружинно-масляным амортизатором создадим Simulink-модель 

(рис. 6.2). 

 
Рис. 6.1. Математическая модель САУ натяжением ленты с тензодатчиком и 

амортизатором. 
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Рис. 6.2. Simulink-модель разомкнутой системы управления натяжением. 

Числовые параметры для данной Simulink-модели вводятся через командное окно 

программы Matlab. Эти параметры следующие: 
b=0.84 

gamma=800 

r0=0.5 

rk=0.07 

rs=(r0+rk)/2 

delta=0.078*10^-3 

r=r0 

g=9.807 

Eb=660*10^6*g 

Fz=35*g 

epsz=Fz/(b*delta*Eb) 

Vpz=7 

Mtzr0=-(-(3/4)*b*delta*gamma*Vpz^2-b*delta*Eb*epsz)*r0 

L0=10 

Tp=pi*r^2/(3*delta*Vpz) 

Keps=2*Eb/(3*gamma*Vpz) 

Km=2/(3*delta*b*gamma*Vpz*r) 

L0=10 

Vkp=sqrt(2*delta*Eb/(pi*gamma*L0)) 

omegakp=r/Vkp 
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Tar0=r0/Vkp 

Tar=Tark 

la=0.4 

ld=0.2 

Ja=0.4 

Car=Ja/(Tar*la)^2 

Ta=Ta0 

Cam=Car 

Kam=2*b*delta*Eb/(Cam*la) 

dzamr=20 

kdr=2*dzamr*la*sqrt(Ja*Cam)/ld^2 

kda=kdr 

dzam=kda*ld^2/(2*la*sqrt(Ja*Cam)) 

Tam=sqrt(Ja/(Cam*la^2)) 

a2=Tam^2 

a1=2*dzam*Tam 

alfaz=Kam*epsz 

L0z=L0-2*la*alfaz 

TL=L0z/Vpz 

KV=(1+epsz)/Vpz 

KL=(1+epsz)/Vpz 

KItz=0.597 

Koctz=Mtzr0/epsz 

kF0=b*delta*Eb/g 

omegad=omegakp/12 

Эта модель включает в себя подсистемы под названием Lineyniy razgon (рис. 5.3) 

 
Рис. 6.3. Подсистема Lineyniy razgon 

Также система включает в себя осциллографы, на которых после начала моделирования 

будет фиксироваться изменение силы натяжения (Scope F0(t)), момент инерции (Scope M(t)), 

скорость печати (Scope V(t)) и относительное удлинение бумажной ленты (Scope eps(t)). На 

следующих рисунках показаны результаты моделирования (рис. 6.4, рис. 6.5 и рис. 6.6). 
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Рис. 6.4. Изменение силы натяжения Рис. 6.5. Изменение момента инерции 

 
Рис. 6.6. Изменение скорости печати 

Используя инструмент Simulink Control Design нужно произвести моделирование 

линеаризованной системы при разных  значениях радиуса рулона ленты для получения 

частотных характеристик, таких как ЛАЧХ и ЛФЧХ (Bode magnitude plot): 

1. Радиус рулона r = r0 (рис. 6.7) 

2. Радиус рулона r = rs (рис. 6.8) 

3. Радиус рулона r = rk (рис.6.9) 
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Рис. 6.7. Логарифмические частотные характеристики при r=r0 

  
Рис. 6.8. Логарифмические частотные 

характеристики при r=r0 и r=rs 
Рис. 6.9. Логарифмические частотные 
характеристики при r=r0, r=rs и r=rk 

 

Рассмотрим теперь замкнутую систему управления натяжением ленты при радиусе 

рулона r = rk и отсутствие амортизатора (рис. 6.10). Также проведем моделирование системы 

для получения переходной характеристики и диаграммы нулей и полюсов. Для этого в списке 

частотных характеристик для моделирования в окне инструмента Linear Analisys выберем: step 

response plot и pole zero map. 

Эти частотные характеристики представлены на следующих рисунках (рис.6.11 и рис. 

6.12). 
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Рис. 6.10. Simulink-модель замкнутой системы управления натяжением ленты 

  
Рис. 6.11. Переходная характеристика без 

амортизатора 
Рис. 6.12. Диаграмма нулей и полюсов 

Затем в замкнутую систему управления включаем  передаточную функцию, 

описывающую поведение амортизатора и также проведем моделирование системы для 

получения переходной характеристики и диаграммы нулей и полюсов (рис. 6.13 и рис.6.14).  
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Рис. 6.13. Переходная характеристика 
системы с амортизатором 

Рис. 6.14. Диаграмма нулей и полюсов 

Как видно на представленных графиках переходная характеристика системы избавилась 

от нежелательных колебаний и стала достаточно устойчивой. 

На осциллографах в Simulink-модели можно посмотреть поведение различных 

параметров системы после включения амортизатора в отрицательную обратную связь (рис. 

6.15 – рис. 6.17). 

  

Рис. 6.15. Осциллограмма изменения силы 
натяжения 

Рис. 6.16. Осциллограмма изменения 
тормозного момента 

 

  62



 

Рис. 6.17. Осциллограмма изменения скорости печати 

После выполнения данной лабораторной работы следует сделать выводы о ходе 

проведения моделирования, проанализировать полученные результаты. А также сделать 

соответствующие выводы о влиянии амортизатора на систему управления лентопитающего 

устройства. 

Сформулировать выводы по результатам выполнения данной лабораторной работы. 
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Варианты заданий к выполнению лабораторного практикума 

№  
вар. 

Скорость 
печати 
V1, м/с 

Длина 
пути 
ленты, 
L0, м 

Момент 
инерции 
амортизатора, 

2мкг ⋅  

Заданное 
усилие 
 натяжения 
ленты, 
Н 

1 5,2 6,4 0,4 180 

2 4,5 5.6 0,35 220 

3 3,3 6,8 0,45 250 

4 4,8 6,2 0,32 280 

5 6,4 7,2 0,38 320 

6 5,7 7,6 0,42 290 

7 3,4 4,2 0,34 240 

8 4,2 6,7 0,39 230 

9 6,7 8,2 0,44 270 

10 6,2 8,4 0,43 310 
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